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OVERVIEW

ADIsimPE is a result of Analog Devices, Inc. teaming with
SIMPLIS Technologies. ADIsimPE allows full simulation of
Analog Devices products in the library while still offering the
entire functionality of the SIMetrix/SIMPLIS Intro version. In
addition, ADIsimPE integrates with ADIsimPower to quickly
verify circuit performance.

ADIsimPE, which is powered by SIMetrix/SIMPLIS, is a circuit
simulation suite optimized for the design and development of
analog and mixed signal circuits. SIMetrix mode is ideal for the
simulation of general non-switching circuits. It provides full
Pspice compatibility for use with industry-standard SPICE
models. SIMPLIS (SIMulation Piecewise-Linear System) mode
simulates the operation of switching circuits with vastly
improved robustness, speed, and accuracy compared to
standard SPICE. It is particularly useful for switching power
supply, PLLs and ADC/DAC applications.

Details are available from SIMPLIS Technologies.

ADIsimPE is intended for Analog Devices customers who do
not have a full license to the SIMetrix/SIMPLIS program. It can
simulate Analog Devices encrypted schematics as well as non-
encrypted Intro compatible ones. The full license version of
SIMetrix/SIMPLIS can simulate all encrypted schematics from
any partnered company.

ADIsimPE offers:

e  Full schematic capture

e  SPICE or SIMPLIS simulation mode

e Waveform viewer and analysis

e More than 1,000 IC models and application circuits to get
you started

e Support by EngineerZone

J ADIsimPE

Powered By SIMetrix/SIMPLIS

The tool includes:

Linear and Mixed-Signal Circuit Simulator - Personal Edition

ADIsimPE powered by SIMetrie/SIMPLIS is a Personal Edtion circuit simulator ideally
suited to evaluate Analog Devices Linear and Mixed Signal Components.

- Bdensive library of ADI IC models and applications schematics

- Full schematics capture and editing capabilties with easy waveform viewing and analysis
- SPICE mode SIMetrix simulator ideal for op-amps, references, Linear Regulators and maore
- SIMPLIS mode simulation optimized for Switching Power supplies, PLLs and more

- Integration capability with ADlsimPower design tools

Far help using this application, please use the help menu or our EngineerZone Forum at:
https://ez analog.com./community/power/adisimpe

Librany content and instructional materals are available at: www analog.com/ADIsimPE

Figure 1. Splash Page from ADIsimPE

PLEASE SEE THE LAST PAGE FOR AN IMPORTANT
WARNING AND LEGAL TERMS AND CONDITIONS.
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GETTING STARTED

Download the ADIsimPE installation file from
http://www.analog.com/ADIsimPE

To download the file, you must be registered with myAnalog.
INSTALLATION PROCEDURES

To install ADIsimPE on your computer (Microsoft® Windows),
use the following steps:

1. Double click adisimpe.exe, which is a self-extracting
executable that starts the InstallShield Wizard.

InstallShield Wizard

Preparing to Install...

ADISiMPE Setup is preparing the InstallShield Wizard,
which will guide you through the program setup process,
Please wait.

Extracting: ADIsimPE.msi

[ |

Figure 2. Preparing to Install

2. Click Next from the initial InstallShield Wizard dialog box.

The license agreement appears (see Figure 4).

| ADIsimPE - InstallShicld Wizarc

Welcome to the ADIsimPE setup ‘Wizard

Thiz \Wizard will install ADI&imPE on wour camputer. Ta
continue, click Mext.

Figure 3. Startup Dialog Box for the ADIsimPE Installation

Accept the license agreement by clicking Next. A
destination directory appears. (If you do not accept the
license agreement, you cannot proceed with the installation
of ADIsimPE.)

[ ADIsimPE - InstallShicld Wizare

License Agreement

Please read the following license agreement carefully.

IMPORTANT MOTICE

The software ['the Software"] that can be used by clicking "l accept the terms of the
licenze agreement'’ at the bottom af this page iz pratected by coppright. The right to
license the Saftware to you belongs to SIMetix Technalogies Limited. The Software may
not be used or copied without our permizssion. It may only be uzed on the licence tems
set out below and we offer you a licence on these terms. BY USING THE SOFTWARE
wOU WILL BE DEEMED TO HAVE READ AND ACCEPTED THESE TERMS. |FvOU
DO NOT AGREE “WITH THESE TERMS, YOU MUST MOT USE THE SOFT'ARE.

accept the terms of the license agreement

()| do nat accept the tems of the license agreement

InstallShield

l < Back ][ Mext » ][ Cancel ]

Figure 4. ADIsimPE License Agreement

Select the destination directory.

The InstallShield default directory for ADIsimPE is
C:\Program Files (x86) and reflects the ADIsimPE version
number. (Your version number may vary from the one
depicted in Figure 5.)

To change the installation directory, click Browse.

After selecting the directory destination, click Next (see
Figure 5). The Ready to Install the Program screen
appears (see Figure 6).

[ ADIsimPE - InstallShield Wizare )

Choose Destination Location

Select folder where setup will ingtal fles.

Setup will install AD01simPE in the following folder.

Tainstall to this folder, click Mext. To install to a differsnt folder, click Browse and select
anather folder.

Diestination Falder

CAProgram Files (+85 54D simPE_710%

InstallShield

[ cBack [ Mest> i[ Cancel ]

Figure 5. Destination Directory

Rev.0|Page 3 of 14


http://www.analog.com/ADIsimPE?doc=ADIsimPE_UG-706.pdf
http://www.analog.com/ADIsimPE
http://www.analog.com/ADIsimPE
http://www.analog.com/ADIsimPE?doc=ADIsimPE_UG-706.pdf
http://www.analog.com/ADIsimPE?doc=ADIsimPE_UG-706.pdf
http://www.analog.com/ADIsimPE?doc=ADIsimPE_UG-706.pdf
http://www.analog.com/ADIsimPE?doc=ADIsimPE_UG-706.pdf
http://www.analog.com/ADIsimPE?doc=ADIsimPE_UG-706.pdf
http://www.analog.com/ADIsimPE?doc=ADIsimPE_UG-706.pdf

UG-706

6.

Click Install to begin the installation, Cancel to quit, or
Back to make installation changes.

| ADIsimPE - InstallShicld Wizarc |

Ready to Install the Program

The wizard is ready to begin installation.

Click Install ta begin the installation.

If you want to review or change any of your installation settings. click Back. Click Cancel to exit
the wizard,

InstallS higld

[ < Back ” Install |l Cancel

Figure 6. Ready to Install

The InstallShield provides a status of the installation of files
and approximately where it is in process (see Figure 7).

If you click Cancel at this point, you will interrupt the
installation of files and be left with an incomplete
installation of ADIsimPE that may not work. (Use the
Cancel button if the InstallShield is idle many minutes and
does not progress.)

" ADIsimPE - InstaliShield Wizarc |

Setup Status

ADIsimPE is configuring your new software installation.

C:\Program Files (286)4A0simPE_ 71 05binsimlib. il

InistallS higld

Cancel

Figure 7. Status of the Installation of Files

Once the InstallShield has installed all of its files and
configured itself in the Windows registry, the InstallShield
Wizard Complete dialog box appears (see Figure 8). Click
Finish to close the dialog box.

[ ADIsimPE - InstallShicld Wizare

InstallShield ‘Wizard Complete

Setup has finished installing ADI=imPE on pour camputer.

< Back Cancel

Figure 8. Installation Finished
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HOW TO USE THE SOFTWARE

To open the software, use the following steps:

1.
2.
3.

Click the Start menu.

Select All Programs.

Choose ADIsimPE 7.20 (where 7.20 indicates your version
number, which may vary). See Figure 9.

ADIsimPE 7.20

—
- ,I Motepad

) Paint 3
4
@ Internet Explorer 4
(
e tetozilla Firefox 3
“
2:_"_?] hdicrosoft Excel 2010 3

P

icrosoft Waord 2010

» Al Prograrns

=
-

‘ Search programs and files §el |

Figure 9. Choose ADIsimPE

The screen in Figure 10 appears with the option of
migrating your old configuration to the new version (if
applicable) and the option to add example files.

The example files are the Analog Devices library, which
includes all Analog Devices encrypted schematics and
models from op-amps to switching regulators, as well as a
good selection of application circuits to get you started (see
the Library of Analog Devices Schematics section).

| Starting ADIsimPE 7.10p for the First ... E‘

Freferences from earlier wersion

“wiould you like to migrate the configuration
fram pour earlier version of AD1simPE?

Yes

st configuration zettings wil be copied
including installed models and spmbols along
with preference settings. & log file showing
what iz copied will be created during this Ho
pIocess
Example files
Wiould you like the example files "
to be installed to your personal folder? @ Yes

) Ho

Figure 10. Starting Up ADIsimPE

4.  After making your selections, click Close. The splash
screen appears (see Figure 11).

Powered By SIMetrix/SIMPLIS

Linear and Mixed-Signal Circuit Simulator - Personal Edition
AD1=mPE powered by SiMetix/SIMPLIS is a Personal Edition circuit simulator ideally
suited to evaluate Analog Devices Linear and Mixed Signal Components.
The tool includes:
Estensive library of ADI IC models and applications schematics
Full schematics capture and editing capabilties with easy waveform viewing and analysis
SPICE mode Slketriz simulator ideal for op-amps, ieferences, Linear Regulators, and more
SIMPLIS mode simulation optimized for Switching Power supplies, PLLs, and mare

Integration capability with AD|simPower design toals

For help using this application, please use the help menu or visit wiw, analog. comAA0 1 zimPE

Figure 11. ADIsimPE Splash Screen

5. Click Ok. The command shell opens (see Figure 12 and
Figure 14).

When ADIsimPE is started from your Windows Start button,
you may open a new (blank) schematic or an existing schematic
using options from the File pull-down menu in the Command
Shell. These operations then open the Schematic Window.
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Simulator SIMPLIS Graphs and Data Help

welcome Co ADISIWPE: Powered by SIMetrix/SIMPLIS

For help using this application, please use the help menu located abowve
or wisit wa, analog. com/ADISimMPE

Figure 12. ADIsimPE Command Shell

Simulator  SIMPLIS Graphs and Data Help
Mew Schermatic e A F It

New Schermatic Wind ow ation, please use the help menu located
erzone forum at:

Open Schematic..,

Open Last Schematic  Ctrl+F9 COMTUNT Ty power fadis impe

Reapen ctional materials are available at:
Save
Save As..
Save All...

E

Save Session

Restore Session

Data

Graph
Symbol Editor
Model Library

- v v v

Change Directory..
Print ...

Options 3
Mifind owvs 3

Edit File

Wiew File

Exit

Figure 13. ADIsimPE Open New Schematic
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File Edit Yiew S-i.mulator Place Probe Probe AC/Moise Hierarchy Monte Carlo Tools
EHd BOPBXCHEIQAK|ZL
f s+ D8 XX KKEE LT

Powered By
Search Show Parts Selector SIMetrin/SIMPLIS

SIhdetrix

Figure 14. Schematic Window

UPDATING ADIsimPE

The library of schematics will continue to grow, particularly as
new parts become available. ADIsimPE can be configured to
regularly check for updates. To do so, from the ADIsimPE
Command Shell window, click Help and select Check for
Updates. The screen in Figure 15 appears. Analog Devices
suggests checking for updates monthly.

Check Updates Maow

Automatic pdate Schedule | Mewver

Figure 15. Update Settings

The check for updates feature periodically checks (via the
Internet) if there is a new release of ADIsimPE. New releases
may contain updated model library content from Analog
Devices and/or enhanced features for the application.

LIBRARY OF ANALOG DEVICES SCHEMATICS

If you opted to have the examples files installed, they are in a
directory named in a manner that reflects its software version,
such as:

C:\My Documents\ADIsimPE\Examples-72

This installation directory has two subdirectories, one for
SIMetrix schematics and another for SIMPLIS schematics.

The schematics encrypted with Analog Devices products are in
respectively named subdirectories:

e C:\My Documents\ADIsimPE\Examples-72\SIMetrix\
Analog Devices\

¢  C:\My Documents\ADIsimPE\Examples-72\SIMPLIS\
Analog Devices\

The schematics for general SPICE applications and linear
circuits are in the SIMetrix subdirectory. The models for
nonlinear and switching circuits are in the SIMPLIS
subdirectory.

Many of the SIMPLIS schematics from Analog Devices for
switching regulators are also available within their respective
ADIsimPower design tools (such as, Microsoft Excel). When
the schematic is exported from an ADIsimPower design tool,
ADIsimPE also obtains settings such as Vv, Vour, lour, as well
as component selection from your current design in the tool.

For more information about the integration between
ADIsimPower and ADIsimPE, see the Quick Start Steps for
Running Power Simulations section.
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LIBRARY OF ANALOG DEVICES MODELS

Encrypted models of Analog Devices parts are available from
within ADIsimPE. Because the models are encrypted, they do
not count towards the ADIsimPE limitations imposed upon
schematic size for simulation.

Before inserting a model on a schematic, make sure ADIsimPE
is in the proper simulation mode, because the available models
are dependent upon what is being used. To change the
simulation mode, in the schematics editing window, select

File > Select Simulator. The resulting dialog box has radio buttons
to choose either SIMetrix (for linear applications) or SIMPLIS
(for nonlinear or power switching applications). See Figure 16.

s

4 Select simulator
i

(1 SlMetriz

LCancel

@ SIMPLIS

Figure 16. Select Simulator

s ADIsimP| m

L AT AL

File Edit View Simulator

ADIsimPE makes a distinction between symbols and models.

e A symbol is what is graphically depicted within the
schematic and shows how the circuit element connects
with other elements.

e A model is a netlist description of the circuit element. The
same schematic symbol may be used for many different
models (or parts). The properties on a symbol specify
which model is used for simulation. Inserting a symbol
does not guarantee that it has an underlying model or the
desired model.

To insert an existing model into your schematic, select from the
Place pull-down and click From Analog Devices Library.

e Ifyouare in SIMetrix mode, the submenu from the pull-
down will show Operational Amplifiers.

e Ifyouare in SIMPLIS mode, the submenu from the pull-
down will show Switching Regulators and Other
Components.

File Sirmulator SIMPLIS_C untitled (Selected) =l

Probe Probe AC/Moise Hierarchy Monte Carlo Tools

% Zg;v2?1gru\5/}gwgttro1 g ﬁl E Repeat Last Place.., Alt+R
E https: Arez. anl l:] # N = @ 8 2 From Model Library.., Ctrl+5
[g Library content & ok nbolll b MW
unnamed From Analog SIMetrix/SIMPLIS
I?? watds analogueol | ] Select by Specification P e e e = =
[ e | S tstahiac At bttt ST L
| Sl . ] Hierrchy L
n SOl Create Madel S
........ Magnetics » L - e e e
Sl 0] passives L
........ Connectors 4 L - e e e
Probe 3
........ Voltage Sources 1
........ Current Sources O .

- Controlled Sources

........ Eias Annotation L

CoLLo ol Semiconductors L

........ Dlgltal » L . . . o o o e e s e

~ ... Digital Generic O

S 3 SOCRSORESERERREE

........ Znalog Functions vl
Select o1 Worksheets » SIMetric

Figure 17. Analog Devices Library
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Additionally, the Show Parts Selector link under the tool
bars is a useful way to locate models for insertion into your
schematic without having to go into the Place pull-down
menu (see Figure 19).

& The highlighted components may not function in SIMetrix mode

Deleting and re-placing the devices may resolve the problem

. . . Mote: ¥ou can setthe 'SIMULATOR' symbol property
The schematic editor allows you to insert any number of parts. to declare which simulators are supported by 3 device

However, the type of simulation (SIMetrix or SIMPLIS)
restricts which models can be in the circuit for simulation. _
Incompatible models are highlighted in a different color (see Figure 18. Error Message when Mixing Models
Figure 18).

' ™
* Recently Added Models * ADP2119
* &l Usger Models * ADP2120
* &)l b odels ADPZ2384
Diode ADPZ2386
Gates ADP2442
HOS 1825
MPM L1846
P05 UCc3g42
PHP L3843
PSU Controllers LC3844
Schottky Diodes LC3845

Voltage References
Zener Diodes

AppEie’ UT
FUIN
G_\n’n o F'GJD'D_Q )
- T wopEne - [T
Al
ConE T
. é_eirncj.lon’s ) EW‘@ ’
e

Filter " [ Apply ] [ Flace J [ LCancel l ’ Help

C:\Prograri Files (864D 2imPE_71MhsupporttModelzhanalog_devices_controllers b

Figure 19. Select Model
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QUICK START STEPS FOR RUNNING SIMULATIONS

ADIsimPE offers SIMetrix/SIMPLIS tutorials. These are found
in the Command Shell window in the Help menu (see
Figure 20).

|, | ADIsimPE Command &

File Sirnulator SIMPLIS Graphs and Data J5E05
Contents
D welcome to ADISimFE: Fowered SIMetrix Tutarials
E For help using this applicati SIMPLIS Tutorial p menu located abowe
@ or wisit www,analog.com/ADIS 1 Sehamekie Efar
é Keyhoard
l tdenu Reference
Uninstalling
Online Manuals — »
P
Check for Updates...
Unlock Features...
About...

Figure 20. SIMetrix/SIMPLIS Tutorials

Another excellent path for understanding how to work with
ADIsimPE is to explore the examples. The examples, if installed,
can typically be found in the command shell by selecting File >
Open Schematic or in the schematic window by clicking File >
Open. The default location is the directory where the examples
are installed.

Loak jn: | | Examples71 j o cf B I
= Marme = Date rodified Type
ey
= | SMetrix 12/11/2013 3:23 PM File folder
Recent Places .
J SIMPLIS 12/11/2013 3:23 PM File falder
Desktop
=)l
Libraries
Computer
i,
w
Netwark 1 Ul ¢
File name: |\ ﬂ Open
Files of tppe: |Schamalic Files j Cancel
™ Open as read-only

Figure 21. SIMetrix/SIMPLIS Examples

QUICK START STEPS FOR RUNNING POWER
SIMULATIONS

Analog Devices power management incorporates the
simulation abilities of ADIsimPE into its recommended
development process. To design your power circuits, use the
following steps:

1. Part and design tool selection.
2. Design and optimization.
3. Simulation.

After entering your design criteria into ADIsimPower for
Step 1, ADIsimPower recommends appropriate parts and
topologies: http://www.analog.com/adisimpower

ADIsimPower lets you download appropriate design tools for
the selected part. These are Microsoft Excel-based.

When you run the respective ADIsimPower design tool on your
local computer during Step 2 with your design criteria and
settings for the part’s features, the tool produces a schematic
and bill of materials for your design that you can further
optimize.

Once Step 2 has given you an optimized design, some
ADIsimPower tools assist you with simulation (Step 3) by
having a SIMPLIS schematic embedded in the tool for export.
All settings relevant to your design and your desired simulation
are exported to ADIsimPE with the model.

When ADIsimPE is launched from a design tool, it is ready to
simulate your design immediately (press the F9 key).

Thus, the preferred way of running SIMPLIS simulations on
Analog Devices power parts is from its respective design tool,
because then you inherit simulation values for:

® Vi, Vour, lour operating conditions.

e Allbill of material components needed for the design.

e  All advanced settings and jumpers.

e  The desired simulation’s settings such as start, stop,
number of data points.

The Simulate with ADIsimPE/SIMPLIS button from the
design tool opens a dialog box to specify the desired simulation
(see Figure 23).

Simulate with
ADIsimPE/Simplis

Figure 22. Button in ADIsimPower (Excel Tool): Simulate with
ADIsIMPE/Simplis
The design tool’s export process accesses the appropriate embed-
ded SIMPLIS model and changes settings based on the current
design state and desired simulation. The export process prompts
for an appropriate directory and name for the exported file.

The default export directory is the location of the Excel design
tool when started. If the design tool was started from within a
ZIP file, the export directory must be changed. The export
process cannot write into a ZIP file.

Rev. 0 |Page 10 of 14
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The default filename for export is the name of the embedded
SIMPLIS model. Renaming of the export file is recommended
to avoid confusion, because settings internal to the file will
changed based on the current state of the design tool and the
desired simulation. If a file in the export directory already has
the desired name, the user is prompted to overwrite the existing
file or cancel the export operation.

The Export and Export & Run buttons both save a SIMPLIS
file for the user to access. The Export & Run button performs
the additional step of starting ADIsimPE (or SIMPLIS) with the
exported file. However, the Export & Run button is disabled if
the design tool does not detect a computer registry entry for
ADIsimPE (or SIMPLIS).

Qutput Simplis/Simetrix Mode

ANALOG
DEVICES

Simulation Options

The simulation options shown depend on (a) the design tool
and (b) the recommended solution from the design tool. Some
design tools may restrict which simulation options are available.
If the solution only has one rail, the option Rail to Simulate is
not present. In meeting customer design criteria to recommend
a solution, the design tool may recommend solutions for which
it does not have a SIMPLIS model. In these cases, the Export
and Export & Run buttons are disabled.

— Desired Simulation

@ Rode + Load Transient + Ripple |

" Bode (only)

™ Load Transient (only)
7 Current Limit + Restart
" Stark Up + LWL

Vin Rise Time

7 shukdown + UYLO vin Fall Time

Mote: At Full Load Current

& vin Minimum

© win Maimum

Rail T Simulate I 1

Export & Run Simplis Model Export Simplis Model {only) | Reset Defaults Cancel

Export directory cannot be within a ZIF file,

Figure 23. Exporting from Analog Devices Design Tools
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DL

Search Show Partz Selectar

Powered By
SIMetrix/SIMPLIS

%WR-overvoltage protection active if H..See datashest
ALirmit-H if Currert Limiit evert occors. See datasheet.

" |s¥HC

TRE L

_MODE 5y

AR
&

o
.

ight= Reserve

LU e O
Dravin By IS0

t

¥ 082

MET unassigned SIMPLIS

Figure 24. Example Schematic Exported Froma Design Tool into ADIsimPE

It is not possible to import the settings from an exported
ADIsimPE (SIMPLIS) file back into an ADIsimPower design
tool.

ADIsimPE permits you to adjust the simulation, generate
results, and explore the full capabilities of the SIMPLIS engine.

The benefits of using ADIsimPE (or the full SIMetrix/SIMPLIS
version) go beyond the simulation/validation of the power
management portion of a design. You can add to the schematic
load circuitry and other parts of your application and simulate
how this would work. Whereas the Analog Devices models are
encrypted to protect Analog Devices’ intellectual property (IP),
ADIsimPE allows the simulation of much larger circuits than
would otherwise be permitted with the free SIMPLIS
distribution.

SIMetrix/SIMPLIS is feature rich software application even
when distributed as ADIsimPE. Its description and operation
are beyond the scope of this document. For more information,
refer to SIMPLIS Technologies documentation.

RUNNING SIMULATIONS FROM ANALOG DEVICES
POWER MANAGEMENT SCHEMATICS

Assuming that an ADIsimPower design tool produced a valid
design, when the SIMPLIS schematic is exported, it is ready for
simulation within ADIsimPE. To run a simulation, select
Simulator > Run item (or press the F9 key).

Additional probes can be placed within the schematic to
observe.
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FEATURES OF ANALOG DEVICES POWER
MANAGEMENT SCHEMATICS

Many schematics for power management provided by Analog
Devices have enhancements that improve the simulation
experience. The main purpose of these enhancements is so that
the data sheet limits may be simulated with easy to understand pull
down menus.

One example is an additional dialog box associated with the
parameters of switching regulators, so that everything
important for simulation of the IC and the IC’s limits can be
easily accessed. This dialog box is accessed when you double-
click on the schematic component, or right-click and select Edit
Part (see Figure 25).

Ridson H 44m =) RdsonL 11.6m

LVLO Threshold [Rizing) Error Amplifier Gm | 4700
“Wreg Current Limit 100 lz‘ Shw' Current Limit | 6.1
Trinon 1250 [+ Trineff 200n
[+] Enable Threshold | 1.17
55 Pin Current 3.2u Iz‘

Ozcillator Tolerance (%] | 0

ok | [ Concel |

Figure 25. Edit Device Parameters: Switching Regulators

Another example is an additional dialog box associated with the
parameters of the output capacitance (Cour). Often the
optimum output capacitance can’t be achieved by a single, real-
world capacitor. Instead, it is achieved by more than one
capacitor in parallel. Although the buck schematic may only
show the symbol for a single capacitor, the real-world design
may call for more than one placed in parallel (see Figure 26).

4  Edit Device Pararﬁ - ﬁ

Effective Capacitance [per Cap if M>1] 27U 8
Equiv. Series Resistance [per Cap if M>1] |3m %
Quantity N [in parallel) 4 %
Iritial Conditian 1.805 =

Use Initial Condition

[ Ok H Cancel ]

Figure 26. Edit Device Parameters: Capacitor

The Edit Device Parameters dialog box for this specifies how
many capacitors are in parallel, their effective capacitance, and
their effective series resistance. This information is critical for
simulation, and is important for the design engineer to know.

The inductor is another component that has been enhanced.

4  Edit Device Parameters ‘ M

Effective Inductance m 8
DC Resistance 259m 8
Initial Condltion |3 &

U'ze Initial Condition

[ Ok H Cancel ]

Figure 27. Edit Device Parameters: Inductors
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ADIsimPE LIMITATIONS

ADIsimPE supports Analog Devices encrypted content as well
as additional circuits. The additional circuits are bound by the
limits of the SIMetrix/SIMPLIS Intro version:

e 120 internal analog nodes
e 36 digital nodes

e 72 digital ports

e 24 digital components

e 36 digital outputs

The internal analog node limit does not apply to the encrypted
content. However, the node limit does apply to nodes from a
customer’s larger application circuit including nodes inside
elements, such as nonencrypted op amps. In practice, the
Analog Devices application schematics already include the
minimum necessary external components to define and
simulate the circuit. Also, when an encrypted model is placed
into a schematic, its internal representation does not count
against the limits.

ADIsimPE cannot simulate encrypted schematics from other
companies.

Legal Terms and Conditions

ADIsimPE has no limits on the size of the schematics that can
be drawn. The limits apply to what can be simulated. These
include:

e A maximum of 15 additional state variables. A capacitor or
an inductor each requires one state variable. Each time-
varying or small-signal AC source requires one state
variable, with the exception of SINusoidal or COSinusoidal
sources, which require two state variables per source.

¢ A maximum of 10 additional capacitors or inductors
combined.

e A maximum of six additional switches, simple or transistor.

e A maximum of six additional logic gates.

e A maximum of 26 states. Each PWL element requires one
state. Each switch requires one state. Each time-varying
source requires one state. Each logic gate requires one state.

¢ A maximum of 100 new topologies. 100 topologies will be
enough for simple switching circuits that use simple
models only. More complex circuits or circuits that have
more complicated models may exceed this limit. Encrypted
models that typically require multiple topologies can
greatly expand this limitation.

The limits are not applicable to the full licensed version of
SIMetrix/SIMPLIS.

Information furnished by Analog Devices is believed to be accurate and reliable. However, no responsibility is assumed by Analog Devices for its use, nor for any infringements of patents or
other rights of third parties that may result from its use. No license is granted by implication or otherwise under any patent or patent rights of Analog Devices. Trademarks and registered
trademarks are the property of their respective owners. Information contained within this document is subject to change without notice. Software or hardware provided by Analog Devices
may not be disassembled, decompiled or reverse engineered. Analog Devices’ standard terms and conditions for products purchased from Analog Devices can be found at:

http://www.analog.com/en/content/analog_devices_terms_and_conditions/fca.html.

©2014 Analog Devices, Inc. All rights reserved. Trademarks and
registered trademarks are the property of their respective owners.
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